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Section 1: Basic GIS Fundamentals 
 

 

Exercise 2 
Exploring Spatial Data 
Use Case: 2012 Drought in Texas 
 

Now that you’ve been introduced to the basic features and tools within ArcMap and ArcCatalog, 
let’s take a closer look at the type of information these tools allow you to explore.  

The main benefit of GIS is that it allows you to view, manage, store, edit, and analyze both 
spatial and non-spatial data. Spatial data are data that contain information about location. It can 
be stored in many different formats, such as shapefiles, geodatabases, and gridded datasets. In 
this next exercise you will investigate different types of spatial data in ArcCatalog and then 
visualize that data in ArcMap.   

Sub-Sections in Exercise 2: 

 
1. Exploring Data Types in ArcGIS 

2. Working with Vector Data in ArcMap 

3. Adding Web Services to ArcMap 

4. Exploring Raster Datasets  
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Exploring Data Types in ArcGIS 
 

Spatial data represent objects on the Earth, such as roads, lakes, and cities.  Spatial data can 
also represent atmospheric phenomena such as temperature, humidity, and snowfall amounts. 
The powerful feature of spatial data and GIS is that this data type can be overlapped to answer 
complex questions. For example, in Exercise 1, you mapped tornados recorded over the past 
60 years. By using the Definition Query you were able to see which States experienced the 
most tornadoes for certain years.  

Spatial data are represented by two types of data models — vector and raster.  Vector data 
represent discrete features such as points, lines, and polygons. GIS terminology refers to vector 
data as “feature classes.” A feature class is composed of a collection of features represented by 
the same geometry type and containing similar attribute fields. 

Raster data consists of cells organized in rows and columns. Raster or gridded data are 
commonly used for continuous fields such as elevation or temperature. Unlike vector data, 
raster data are not used for discrete data such as points, lines, and polygons. Some common 
raster data examples are aerial photographs, satellite imagery, Digital Elevation Model (DEM), 
and background images. Raster data are also commonly used for thematic data, such as land 
use. However, this can also be used for continuous data such as elevation, temperature, and 
radar.  

In the next few steps you will explore feature classes and raster dataset. 

 Explore vector files in ArcCatalog  

In this first step you will explore different types of vector datasets in ArcCatalog. Vector data 
represents real world objects as discrete points, lines, or polygons (areas). 

 

 Click Start > All Programs > ArcGIS > ArcCatalog. 

 Click File > Connect To Folder …. 
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 In the Connect to Folder window, navigate to the C:\Exercise2\, and click OK.   

 

 You will see this new folder connection appear in your Catalog Tree.  

 

 In the Catalog Tree, expand the folder connection to C:\Exercise2\, by clicking 
on the + sign beside the folder. 

 Double click on the data folder so that its contents appear in the contents 
window.   

 

 

 

You should now see all the datasets you will be working with for exercise 2. 

In the contents list, the datasets with green icons are called shapefiles. A shapefile is a 
vector type of data format that stores information about a single feature class. The geometry 

type of the shapefile can be seen in the shapefile icon – points , lines , and polygons  

.   

 Select allRivers.shp in the left-hand window (Catalog Tree).  

 Click the Preview tab in the Catalog Window. 

 Change the Preview type from Geography to Table using the dropdown at the 
bottom of the Catalog Window. 
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This table is called an attribute table. All vector data have an associated attribute table 
providing non-spatial information about the features. In this particular dataset, you can see 
there are many attribute fields associated with each feature.   

 

 Scroll right to the end of the table. 

What is the name of the last field in the table? 

Now that you’ve seen the non-spatial information for allRivers.shp, you will explore some of 
its properties.   

 

 Either right-click or double-click on allRivers.shp in the Catalog Tree to open the 
shapefile Properties window.   

 

Notice that the Shapefile Properties window in ArcCatalog has fewer tabs than the Layer 
Properties window you saw in ArcMap in the previous exercise. Since you cannot 
manipulate data in ArcCatalog, you do not need many of the extra tabs. 

 

 Click the XY Coordinate System tab.   
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What coordinate system is this dataset stored in? 

 Click the Fields tab.   

 

This tab shows the field names and data types in the attribute table. If you wanted to add 
additional information about each feature, it is possible to add a field to the shapefile using 
this window.   

 

 Click Cancel to close the Shapefile Properties window. 

 

Every shapefile that you see listed here in ArcCatalog is actually composed of a series of 
files that each performs a specific function in making the spatial layer work properly. 
Remember in the previous exercise, you learned that ArcCatalog should always be used 
instead of Windows Explorer when managing data files. This is because ArcCatalog is 
capable of displaying each shapefile as ONE single file whereas Windows Explorer can only 
show all the individual files. If just one of these individual files is deleted, there is a chance of 
corrupting the shapefile. You will now take a look at a shapefile in Windows Explorer. 

 

 Click Start > Computer.  

 When the Windows Explorer opens, navigate to C:\exercise2\data. 

How many files start with allRivers? Write each of the file extensions you see associated 
with allRivers. 

The allRivers shapefile is made up of six files. A shapefile must have at least three of these 
files to be read correctly — .shp, .dbf, and .shx.  While only three are necessary, many 
shapefiles, like allRivers, are made up of more than three files. The additional files store 
information such as indexes, metadata, and projection information. The files are as follows: 

• SHP - This file holds the feature geometry information. 

• DBF - This Dbase file holds the attributes associated with the features. 

• SBX, SBN, and SHX- These files are index files for faster searching and querying of the 
data. 

• PRJ - This is the file that holds the projection information about the shapefile. 

• XML - This is the metadata file. 
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Even though the allRivers shapefile is made up of only six files, you were able to count 
seven. The seventh file is called a lock file. This file protects the shapefile when it is open in 
a program. Because you are currently viewing the allRivers file in ArcCatalog, this extra file 
will prevent the shapefile from becoming corrupt if someone else tries to view/edit it while 
you have it open. 

 

 Explore feature classes in a file geodatabase 

In the exercise2 directory within Windows Explorer, you may notice that there is a directory 
called module2.gdb. This is a file geodatabase. Geodatabases are an Esri vector data 
format that does not have the same file-size limitations as shapefiles and provides the user 
with some additional functions. Despite their flexibility, this file type is an Esri proprietary 
format and is not open source or published. You will need to consider who will be using your 
data in the future before selecting this format.  

 

 Double click on the folder module2.gdb to look inside this directory.   

 

Similar to a shapefile, a file geodatabase is composed of many files that hold the attribute 
information, spatial information, and indexes about the spatial data.   

 

 Close the Windows Explorer. 

 In ArcCatalog, expand the file geodatabase called module2.gdb in the Catalog 
Tree.   

 

Inside this file geodatabase there are several vector datasets. These datasets are called 
“Geodatabase Feature Classes.” Like feature classes stored in a shapefile, geodatabase 
feature classes can be points, lines, or polygons.  

 

 Double click on cities in the module2.gdb to open the Feature Class Properties 
window. 

 

As you may have noticed, a geodatabase feature class has more properties than the 
shapefile. This allows you to access some of the additional functions that are available when 
using geodatabases. 

 

 Click through the tabs in the Feature Class Properties. When you are finished, 
close the Properties window by clicking Cancel. 
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 Explore raster data 

In the Catalog Tree you can see symbols that look like grids.  This is the symbol for a 
raster layer.  

 

 Double click the raster layer landcover.tif to open the Raster Dataset Properties 
window.  

 

This file is the National Land Cover Dataset from 2006 published by the USGS.  

Notice that the properties are different than those you saw in the shapefile and geodatabase 
feature classes. Under the first tab, General, you can find information about the number of 
columns and rows, the cell size, and the projection information.   

 

 Click Cancel to close the window.   

 Click the Preview tab if necessary.   

 If needed, change the Preview type from Geography to Table.   

 

Some raster datasets can have attribute tables; however, raster tables are structured 
differently than vector tables. As you already learned, raster datasets are composed of rows 
and columns of individual cells. Each of these cells is assigned a value. In this dataset there 
are 17 unique Value classifications, each representing a type of land cover. The Count 
column specifies how many cells in this dataset are assigned the corresponding value in the 
Value column.  

Take some time to explore the data further within ArcCatalog. When you are finished, close 
ArcCatalog. 

You have just explored some of the most common vector and raster data formats used in 
GIS - shapefiles, geodatabase feature classes and rasters. In the next section you will 
display and analyze these datasets in ArcMap. 

 

 Close ArcCatalog. 
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Working with Vector Data in ArcMap 
 

From 2011 through 2012, Texas experienced a severe drought. This drought caused many 
wildfires and loss of crops. For the rest of this exercise you will work with weather and climate 
data for the state Texas to better understand the drought and its impacts upon the state of 
Texas. 

 Working with vector data in ArcMap 

In this step you will open an existing ArcMap document and begin to explore information 
related to the Texas drought.  

 Start ArcMap by clicking Start > All Programs > ArcGIS > ArcMap.   

 

When the dialog appears you will choose to start ArcMap using an existing map.  

 

 

  

 

 Double-click Browse for more… under “Existing Maps” in the tree on the left.   
Navigate to C:\exercise2\maps and double-click Module2.mxd to open the map 
document. 

 

If in Exercise 1 you left the Catalog window docked, you can click the Auto Hide button to 
hide the window. 
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In the center of the screen, you should see a map of the world. On the left, you will see the 
Table of Contents (TOC) describing the layers (datasets) included in the map. These layers 
are contained in the Data Frame named “Module 2.”   

A Data Frame can be thought of as a map containing a number of data layers and 
properties such as projection, display extent, and annotation. The Data Frame in our map 
contains four Group Layers – Wildfires, Regional Scale, Global Scale, and BaseData.   

A group layer is a way to organize layers in the map — it is a group storing many other 
layers. In this map example, our layers are grouped together based on scale. The layers in 
the Global Scale group layer are set up to be viewed when zoomed all the way out. The 
layers in the Regional Scale group layer are set up to be viewed after you zoom in. First, 
you are going to explore our global scale data. 

 

 Click the + sign to the left of the group layer Global Scale to open the group 
layer in the Table of Contents. 

 

 

  

This group layer contains two individual layers (Lakes, Administrative Lines). The symbols 
used to display these features in the map are shown below the layer names in the Table of 
Contents. For example, the Administration Lines layer is drawn on the map with a thin grey 
line.   

 

 Turn off the layer Administration Lines in the Table of Contents by clicking the 
box to the left of the layer name. 
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Now all the country boundaries have disappeared.   

 

 Turn the Administration Lines layer back on. 

 Right-click on Administration Lines in the Table of Contents and select Open 
Attribute Table. 

 

In the table, each row is an individual feature within the Administration Lines feature class. 
Each column, called a Field, has a field name and describes a particular aspect of the 
individual feature. The first field is named “OBJECTID*.” This field defines a unique identifier 
for every feature in the dataset. The asterisk shows that there is an index created for this 
field. 

You’ll notice that the field “Shape*” also has an asterisk. In this field, the software has 
automatically added information describing the geometry of the object (Polygon, Point, 
Polyline, etc.). Every feature within a dataset will always have the same shape. Because this 
is a polyline shapefile, “Polyline” is the shape listed in the “Shape” field for every feature.  

Towards the bottom of the window you see (0 out of 185 Selected).  This tells you how 
many features are in the dataset. 

This table works much like any database table. You can sort and hide fields, as well as 
select rows.   

 

 Select a feature (row) by left-clicking in the grey box to the left of the 
“OBJECTID” field.  

 

 

 

You will see the entire row highlighted. By selecting a feature in the table, you also select 
this same feature on the map. Notice that the polyline you selected is highlighted on the 
map.   

The number of selected features is noted along the bottom of the attribute table where it 
says “(1 out of 185 Selected).” You can select multiple features either by holding down the 



© 2015 UCAR and UNC Asheville  2-11 

 

SHIFT key and clicking another row, or by using the CTRL button to add and remove 
features from your selection one at a time.   

Selection is a powerful tool in GIS. Because the attribute table is linked to spatial features on 
the map, queries can be used to select features based on either non-spatial or spatial 
information. 

 

 Click the Clear Selection button in the Attribute Table to de-select all features.   

 Close the Attribute table by clicking the X in the top right corner of the window. 

 

 Explore layer properties 

Once a dataset is added to ArcMap it is referred to as a layer. A layer is the visual 
representation of spatial data and contains information about the data source (e.g. shapefile 
or geodatabase feature class), and how the data are displayed. You will now explore some 
of the layer properties in your map document. 

 

 Double click on the group layer Global Scale in the Table of Contents to open 
the Group Layer Properties Window.  

 Click the General tab. 

 

In the Scale Range box, there is a scale range set for the data inside the group layer. A 
scale range is the scale at which data are visible. In this situation the data in the Global 
Scale group layer will turn off when zoomed in beyond 1:40,000,001. Because this property 
is set at the group-layer level, it is not necessary to set the same property at the feature-
layer level; any data you add to this group layer will take on this property. 

 

 

 

 Close the Group Layer Property window by clicking Cancel. 

 Double click on the layer Lakes in the Table of Contents to open the Layer 
Properties window.   

 Click the General tab.   
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In the Description section it is possible to add information about the layer, such as how to 
use the layer and any credits necessary.  

 

TIP: This should not hold information about the underlying data type itself, just about the layer. All 

metadata about the underlying data should be stored in the .xml file that is part of the shapefile.  

 

 Select the Source tab.   

 

The Source tab contains information about the data extent, data type, data location on disk, 
geometry type, and projection. 

What Data Type is this file? 

What Geometry type is this file? 

It is important to remember that layers hold information about how to draw the dataset, not 
the dataset itself. As you can see in the source tab, Lakes is actually stored in a shapefile 
called lakes.shp. 

What is the path to this dataset? 

 Click the Selection tab.   

 

By default when a feature is selected in ArcMap it is highlighted in a turquoise color. You 
can set up your own selection preferences and use different selection symbols and colors 
for different layers. We will leave the default for now. 

 

 Click the Display tab.   

 

There are many properties that can be set in this tab.   
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 Check the box to Show MapTips using the display expression. 

 Click OK to close the Layer Properties window. 

 Without zooming in, hover your mouse over one of the Great Lakes. 

 

You should see the name of the lake pop up.  This is a map tip.   

 

TIP: Because the field to display was set to Name, this is the value we see. 

 

 Click the Identify button and click the same lake you just hovered over. 

 

Now you will see the Identify window appear. In the top section you see the name of the 
layer and the primary display field, which you set in the Layer Properties window. In the 
bottom section you see all the attributes and their values for this feature. 

 

 Close the Identify window. 

 Double click on Lakes in the Table of Contents again to open the Layer 
Properties window. 

Support for Hyperlinks 
– provides additional 
information about 
features through 
access to web page, 
videos or document. 

Feature Transparency 

Primary field viewed in 
Identify dialog box and 
map tips. (we will 
explore these later) 
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 Next click the Symbology tab.   

 

This tab allows you to set up how you display your data. Notice that this shapefile is 
displayed using a solid light-blue color. You will spend more time in Exercise 3 learning 
about the Symbology section. 

 

 Click the Fields tab.   

 

In this tab, you can turn fields on and off. By turning a field off, you can hide the field in the 
attribute table so it is no longer visible. This is a nice way to clean up tables and tailor them 
to the particular map without deleting any information.  

It is also possible to change the alias of fields within this tab. A field alias is the name users 
will see when viewing the attribute table and when requesting information about the data.   

 

 In the left-hand panel uncheck the box next the field FID and Shape.  

 Now click on the field name name_alt. In the right hand panel, change the alias 
of the field to Alternative Name.  

 Click OK to close the Layer Properties window.   

 

 

 

In the next step you will take a look at the attribute table and see the changes you just 
made. 

 

 Right-click on the layer Lakes in the Table of Contents and select Open Attribute 
Table.   

 

Notice that the table only shows 5 fields. The FID and Shape fields are hidden, but they 
have not been deleted. Also notice that one of the fields is now named Alternative Name.   

 

 Close the Attribute table. 
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 Working with scale  

Map scale is the relationship between the distance on a map compared to the distance on 
the ground.  A map scale of 1:40,000,000 means that 1 unit on the map represents 
40,000,000 units on the ground.  It does not matter what the units are they can be feet, 
meters, or miles, however, they must be same between the map and the ground.  In this 
example you can think of 1:40,000,000 to be 1cm on the map represents 400km 
(40,000,000cm) on the ground. 

 

 Click the Zoom In tool on the Tools toolbar. Draw a box around the continental 
United States to zoom in.  

 

Remember, the Regional Scale group layer is set to only be seen when the maps scale is 
less than 1:40,000,001, so make sure you have zoomed in past 1:40,000,001.  

TIP: You can see the current scale of your map in the Standard Toolbar. 

 
 

Now that you are zoomed in past 40,000,001 the Regional Scale group layer turns on and 
the Global Scale group layer turns off.  Also notice that in the Table of Contents the box 
beside Global Scale is greyed out with a scale bar underneath. 

 

 Click on the drop-down arrow beside the map scale to see all the pre-defined 
standard map scales. 

 

 

 

 

 

 

 

 Select 1:10,000,000. 

 Expand the group layer Regional Scale by clicking the + sign beside the name in 
the Table of Contents.  

 

Within this group, you’ll notice that the Cities layer is greyed out. This is because this layer 
has its own scale range set. 
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 With the Zoom In tool still selected, draw a box around the state of Texas.  

 

As long as you are zoomed in past 1:8,000,000 (less than 8,000,000), you will see the Cities 
name become active in the Table of Contents and more detail pop up on your map.  

 

 Exploring and downloading data for Texas 

In the next few sections you are going to take a closer look at the state of Texas to examine 
the impacts of drought over the past few years. To do this, you will need to add some more 
information to your map. The first layer you will add displays drought information. This GIS 
data can be downloaded from the U.S. Drought Monitor website 
http://droughtmonitor.unl.edu/.  

 

 In ArcMap, right-click on Module 2 (Data Frame) in the Table of Contents and 
select New Group Layer.   

 

This created an empty group layer.   

 

 Double click on New Group Layer in the Table of Contents to open the Group 
Layer Properties window.  

 In the General tab, change the Layer Name to Drought Monitor and click OK.   

 Click and drag the group layer Regional Scale above the Drought Monitor 
group layer in the Table of Contents. 

 

In this next step you will add data to the group layer.   

 

 Right-click on Drought Monitor group layer and select Add Data… 

 Navigate to C:\Exercise2\data\ and select usdm110628.shp. 

 Next hold down the SHIFT key and click on the usdm120626 and usdm130625 
layers. 

All three usdm files should now be selected.   

 

 Click Add.  

 If a warning appears about the data being in a different coordinate system than 
the Data Frame click Close. 

Spatial data can be stored in many different coordinate systems. Each system is just 
another method of defining where features are located on earth. Using a consistent 
coordinate system ensures that different datasets overlay properly. The warning you just 
saw is telling you that the data from the Drought Monitor are defined in the North American 
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1983 coordinate system (NAD83), while our dataset in ArcMap is stored in the WGS 1984 
coordinate system. You will learn more about coordinate systems in Exercise 5, but for now, 
it is sufficient to simply recognize that our new dataset is in a different coordinate system 
than our map. This will not prevent you from working with the data at this time. 

The dataset appears in ArcMap as three separate layers. Because the layers have not been 
appropriately symbolized yet, it is difficult to understand what the lines and colors are 
indicating.   

You will open the layer property window to set up the symbology for the layer.   

 

 All three layers are now highlighted in your Table of Contents.  Click on any white 
space in the Table of Contents to unselect the layers. 

 Double click on the layer usdm110628 to open the Layer Properties window.   

 Click the Symbology tab. 

 

You can symbolize the data in a number of ways. One way is to choose the colors and 
symbolization method ourselves. In Exercise 3 you will spend more time learning about how 
to do this. Another convenient method is to use a symbology scheme that has already been 
set up and saved in a layer file. 

A layer file is a file that stores properties about spatial data. The properties you viewed in 
the Layer Properties window can be saved to a file with the extension .lyr and applied to any 
number of other datasets in ArcMap. They are very helpful when you need to symbolize 
different data in a similar manner. For example, to easily see how the drought has changed 
over the years, all our drought monitor shapefiles will need to be symbolized similarly. To do 
so, you will import the symbology from a layer file already saved in C:\exercise2\data\layers 
called droughtmonitor.lyr.   

 

 In the Symbology tab, click the Import... button located on the top right corner of 
the window.  

 Click the Browse button. 

  

 

 Navigate to C:\exercise2 \data\layers and click droughtMonitor.lyr.  

 Click Add.  
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 Click OK in the Import Symbology window. 

 Make sure the Value Field used to symbolize the dataset is set to DM and click 
OK. 

 

 

      

 

 

 Back in the Layer Properties window click the General tab.  

 Change the Layer Name to Drought Monitor June 28, 2011. Click OK to apply 
the settings. 

 

Now the June 28th, 2011 drought monitor is symbolized by the drought monitor intensity.  
The darker red shows higher drought monitor intensity and therefore, represents more 
intense drought. 

 

 Repeat the actions above to set the layer symbology for the other two layers 
(usdm120626 and usdm130625) to match droughtMonitor.lyr. Make sure the 
remaining layers are named according to the table below. 

 

Layer   Name 

usdm120626  Drought Monitor June 26, 2012 

usdm130625  Drought Monitor June 25, 2013 
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 Turn off the layers Drought Monitor June 28, 2011 and Drought Monitor June 
26, 2012.   

 Be sure the Drought Monitor June 25th, 2013 is turned on. 

 

You are now looking at the Drought Monitor for the end of June 2013.  Now let’s take a look 
at the Drought Monitor for June 2012. 

 

 Turn off the layer Drought Monitor June 25, 2013 and turn on the layer 
Drought Monitor June 26, 2012. 

 

Now you are viewing the Drought Monitor for the end of June 2012. 

 

 Turn off the layer Drought Monitor June 26, 2012 and turn on the layer 
Drought Monitor June 28, 2011. 

 

Now you are viewing the Drought Monitor for the end of June 2011. 

Visualizing the drought monitors is one way to compare the severity of drought over the 
years. Another way is to look at a specific location and identify the drought monitor intensity 
at that location for each of the three years we downloaded.   

 

 Turn on all Drought Monitor layers in the Table of Contents. 

 Click the Identify tool and click on the star representing the city Amarillo (located 
in the northern part of the state).  

 In the Identify window, use the dropdown menu to change the Identify From: to 
<Visible layers>.   
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 Click the city of Amarillo again.    

 Using the Identify tool, what are the Drought Monitor values for 2011, 2012 and 
2013 (enter your answers in the table below). 

 

CITY June 28, 2011 June 26, 2012 June 25, 2013 

Amarillo    

Houston    

San Antonio    

Dallas    

   

 Close the Identify window. 

 Turn off the Drought Monitor group layer in the Table of Contents. 

 

Adding Web Services to ArcMap 
 

 Add a Web Map Service 

In recent years, GIS technology has been moving towards online mapping and data. The 
Open Geospatial Consortium (OGC) has played a major role in making this possible by 
developing a standards-based approach using open protocols to share data via the web.  

A Web Map Service (WMS) is one of the standard protocols. Many organizations distribute 
data and maps through WMS. You will access a WMS distributed by NOAA to look at radar 
compositions.  

 

 To add a Web Map Service to ArcMap click the Add Data button.  

 In the Add Data window click the drop down arrow in the Look in: drop-down box 
and select GIS Servers. 

 

 



© 2015 UCAR and UNC Asheville  2-21 

 

 

 

 In GIS Servers, double click Add WMS Server.   

 In the URL text box type in 
http://nowcoast.noaa.gov/arcgis/services/nowcoast/radar_meteo_ima

gery_nexrad_time/MapServer/WmsServer? 

 Click the Get Layers button. Notice all the different layers this Web Map Service 
provides. 

 Click OK. 

 In the Add Data window, double click on WMS on nowcoast.noaa.gov.  

 Click WMS and click Add. 

 

A new layer is added to the bottom of the layer list in your Table of Contents. This layer is a 
mosaic Radar layer.  

 

 Drag the BaseData layer in the Table of Contents below the NOAA NWS 
NEXRAD MRMS Weather Radar Imagery layer. 

 Zoom into an area that has some weather activity.   

TIP: You may need to zoom out to see where there is some rain.  This is a real-time radar web 

mapping service. 

 

The radar is a raster layer. In this dataset, every cell in the raster has a value that represents 
the reflectivity in dBZ (decibels). The higher reflectivity means more intense precipitation. 

 

 When you are finished exploring the radar data, turn in off in the Table of 
Contents. 

 Working with non-spatial data 

In this next step you are going to use a .csv file to add non-spatial weather station data for 
Texas. This dataset was downloaded from the National Climatic Data Center (NCDC).  

 

 In Windows Explorer, navigate to C:\Exercise2\data and open 
ncdc_2010_2012_monthly_station_data.csv with Excel. 

 

The first few columns contain information about the station’s name, elevation, and location 
in latitude and longitude. We will use the latitude and longitude columns for displaying the 
station data on our map in ArcMap. The variable definitions are listed below: 
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HTDD  Heating Degree Days 

CLDD  Cooling Degree Days 

DPNP  Departure from Normal Monthly Precipitation 

MMNT  Monthly Mean Minimum Temperature 

TPCP  Total Precipitation 

EMXP  Extreme Maximum Daily Precipitation 

MNTM  Monthly Mean Temperature 

MMXT  Monthly Mean Maximum Temperature 

DPNT  Departure from Normal Monthly Temperature 

 

 When you are finished looking at the data in the excel file, close without saving. 

 Make sure you are still zoomed to Texas. 

 Back in ArcMap, click the File > Add Data > Add XY Data.  

 In the Add XY Data window, click the Browse button, and select 
C:\Exercise2\data\ncdc_2010_2012_monthly_station_data.csv.  

 Click Add.   

 Make sure the X Field is set to LONGITUDE and the Y field is set to LATITUDE.   

 The Coordinate System of Input Coordinates should be automatically set to 
GCS_WGS_1984.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Click OK to add the data as points on the map.  

 Click OK again when a warning appears about the table not having an Object-ID. 
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A new layer is added to the top of the layer list in the Table of Contents and 5 points have 
been added to the map. These points are the station locations. Each point will have monthly 
summaries for the years 2010 through 2012 for the variables listed in the table above. 

   

TIP: Non-spatial datasets added to ArcMap through the Display X,Y tool are called an Event Layer. 

 
It is hard to see the points on the map.  You will change the symbology so that this layer is 
more visible. 

 

 Click on the symbol for the layer ncdc_2010_2012_monthly_station_data.csv 
in the Table of Content. 

 

 

 In the Symbol Selector that appears set the symbol to Circle 1 and click OK. 

 Click the Identify tool on the Tools toolbar and click the station that is close to 
Amarillo. 

 

Notice that three features are identified.  One feature represents June 2010, another one 
represents June 2011, and the third is June 2012.  You can tell the date by looking at the 
DATE field 

What is the Total Precipitation TPCP for June for each year? (units is HI - hundredths of an 
inch)  - The DATE field will identify the year.   

The unit HI means that the value of 100 means 1 inch. 

201006 (June 2010) 

201106 (June 2011) 

201206 (June 2012) 
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What is the Monthly Mean Temperature MNTN? (units TF - tenths of a degree in F) 

The units tenths of a degree in F means that a value 700 is 70.0 F 

201006 (June 2010) 

201106 (June 2011) 

201206 (June 2012) 

 

 Close the Identification window. 

 

So far, you have used the data from the US Drought Monitor to see the areas of drought 
across Texas since 2010. You have also looked at monthly station data to get more detailed 
temporal weather information for specific cities.  

In the next steps, you will look at some of the impacts of the Texas drought. Using products 
derived from MODIS satellite imagery, you will examine the number of wildfires that burned 
in Texas in 2011 and 2012 as compared to 2002. 

Exploring Raster Datasets 

 Working with Fire location data 

In this section, you will look at the location of wildfires in 2011 derived from MODIS satellite 
imagery. You will then compare these data to the data from a wetter year, 2002. 

One of the costliest wildfires in Texas history was the Bastrop County Complex Wildfire 
which broke out on Labor Day 2011. This fire burned more than 1600 homes and claimed 2 
lives. The Bastrop County Wildfire was one of tens of thousands of wildfires in Texas that 
summer.  

 

 Turn off the ncdc_2010_2012_monthly_station_data.csv Events layer. 

 Turn on and expand the group layer Wildfires in the Table of Contents.   

 

This group layer contains two fire locations datasets (one for 2002 and one for 2011), a 
layer outlining Bastrop County, a gridded land-cover dataset, and two gridded layers from 
satellite imagery (LandSat). You are going to first explore the fire locations. 

 

 Right-click on the layer fireLocations_MODIS_2002 and select Open Attribute 
Table.   
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TIP: If you are interested in learning more about the fire locations MODIS data or downloading this 

yourself, visit the following website.  http://activefiremaps.fs.fed.us/gisdata.php 

 

The table contains information about each fire detected in 2002 via MODIS. In this quick 
analysis we will investigate the number of fires in 2002 versus 2011and where these fires 
occurred. 

In the table below write the number of fires detected in 2002 from the MODIS satellite. Then 
open the table for the layer fireLocations_MODIS_2011 and write down the number of fires 
detected in 2011. HINT: the number of fires detected is the total number of features in each 
dataset. Refer to Step 4 if you can’t remember how to find this information. 

 

Year Number of Fires Detected 

2002  

2011  

 

Notice that there were many more wildfires detected in the year 2011 than there were in the 
year 2002.   

 Close the Attribute Table window. 

 Turn on the layer Bastrop County in the Table of Contents.   

 Right-click on the layer Bastrop County and select Zoom to Layer.  

 Now that you are zoomed into Bastrop County, turn off 
fireLocations_MODIS_2002  

 

The red points are the fire locations detected in the MODIS imagery.  The Bastrop County 
Complex wildfire burned mostly forested areas (green area in Land Cover dataset).  

Many of these datasets can be found at EarthExplorer http://earthexplorer.usgs.gov/.  

 

 Turn on the layer July9th, 2011 LandSat. 

 

This is an image that is derived from a multispectral satellite dataset. That means that the 
data were captured at specific frequencies across the electromagnetic spectrum. This image 
of the area around the burn site is a helpful way to visualize what is happening on the 
ground. 

 

 Turn off the fireLocations_MODIS_2011 layer. 
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In our image, the greens are forested regions, the pinks are crops, and the white/grey is 
urban. Notice that the region that experienced the Bastrop Complex fire is very green.   

 

 Turn off the July 9th, 2011 LandSat layer and turn on the Sept. 11th, 2011 
LandSat layer.  

 

This image was taken on Sept 11th, 2011, about 6 days after the fire burned. Notice the 
burn area from the Bastrop County Complex fire is clearly visible.   

 

Do you see any other burn-scar areas visible in the satellite imagery that match a fire 
detection point from the MODIS file? 

 

 Turn on the fireLocations_MODIS_2011.   

 Spend some time and explore the fire areas.   

 Once you are finished exploring the data, click File > Save As and name your 
new map BastropFire.mxd save the map in C:\Exercise2\maps. 

 Close ArcMap. 

 

 

 

 

 

 

 
 


